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About SW ROAD V2 

The SW ROAD was developed during 1993 by WELINK Consultants. Later it was adopted by 
SOFTWEL (A sister concern of WELINK) and has been upgrading and supporting it since 2000. It 
was extensively applied in design and drawings of many road projects in Nepal including ADB 
funded (TRP, RNDP, RCIP, RRRSDP, DRLIP, PPC2, PPC3), World Bank Funded Projects RSDP, 
Indian Exim Bank Project (RIP 1, RIP 2, and RIP 3), SDC funded DRSP Roads and many local 
roads and hydropower project access roads. It has more than 1000 clients in Nepal and abroad.  

Present SW ROAD V2 is a significant upgrade to the previous version of SW ROAD 2010. It 
includes multicore parallel processing, better graphics and higher computation speed, designing 
of multilane roads, multi alignment, handling of background imageries, 3D view and road animation 
and cost estimation. The version is self-updating such that user gets automated update notice.  

The SW ROAD V2 comes with five variants of deployment: 

a) Learning Version: Intended for learning purpose and provided at free of cost. It is of same
capability as Professional Version but limited to design up to 2.5 Km at a time.

b) Professional Version: It is an upgrade to previous version of SW ROAD and is available to
all previous users of SW ROAD.

c) Enterprise Version: It has additional tools e.g., design of pavement, retaining walls, small
bridges etc. and enhanced graphical capability.

d) Server Version: It is targeted for firms and has Professional Version operating under a
central database with multiple licenses with concurrent design capability.

e) Cloud Version: It is intended for departments/road agencies/projects for managing and
maintaining numerous design works including monitoring of the construction and
maintenance works in cloud.

Development Credits 

Avinab Malla - Avinna Malla - Dhiraj Bajracharya - Dibya Pd Pradhan - Hari K Dhonju   
Kabindra K Shrestha - Lav Maharjan - Prashant Malla - Raj Mohan Sijakhwa – Sanjog Shakya 
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Specification 
• Built-in tool, DTM for topographic map preparation.
• Plan/Profile/ Cross-Section can be viewed in same window.
• Generate 3-D View instantly.
• Support online tile imagery and offline images for background reference.
• Support Digital elevation Model for design.
• Export drawing in print-ready format.
• Export detail quantities and cost instantly for reporting.
• Prepare BoQ of the project with ease.

System Requirement 
Operating System: Windows based OS (Windows 10 Recommended) 

Supported OS: Windows 7 with SP1, Windows 8.1, Windows 10 

Microsoft .NET Framework 4.8 

Processor: 2.5 GHz (3+ GHz recommended) 

Memory: 4 GB (8GB recommended) 

Disk space: 2.0 GB. 

DirectX 10 

Installation Note 
Setup Instructions for SW Road V2 Professional 

Follow the instructions below if you are upgrading from SW Road 2010 or earlier, or if you just 
purchased a new key.
Note: Microsoft .NET Framework 4.8 is required to run SW Road V2. You can 
download it from Microsoft official page. 

• Register an account with Softwel. You can register an account from Softwel official page.
• Once you register, an e-mail will be sent to you containing the activation link. Click on the link

to sign in and activate your Softwel account.
• Go to the Downloads page of Softwel.
• Download the SW Road V2 Setup

Download Utility.
• Run the Setup Download Utility.
• Enter your Softwel account email

and password to sign in.

https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-offline-installer
https://swroad.softwel.com.np/Login/SignUp
https://downloads.softwel.com.np/Download
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• Once logged in, make sure the key is inserted into your USB port.
• Press the "Get Key Information" button.
• Verify the key information and then press the Request Installer button.

• Softwel will now prepare your installer and you will receive the download link and your
product key in your email. This may take up to 10 minutes. The download link will only be
valid for 24 hours.

• Download the setup from the link e-mailed to you and run it.
• The setup will ask for a product key. The product key has the format XXXXX-XXXXX-

XXXXX-XXXXX-XXXXX. Enter the complete product key, including dashes.
• Once installed, you can start SW Road V2 from your desktop or the Start menu. The USB

key needs to be connected to your computer all the time and the program will stop working
if the key is removed.
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Visit Here to view the registration and download the video on YouTube. 

Forgot Log in Password 

If we forgot the log-in password for the Softwel Account, we can reset the password from the Softwel official download 
page.  

i. For this visit https://downloads.softwel.com.np

ii. Click on “Login”

iii. Login page will be opened. Just below the Log-in button, click on “Forgot Password?” which will open another
page where we input the registered email address and click on “Submit”.

iv. A link for resetting the password will be sent to the registered email. Click on the link to reset the password.

https://www.youtube.com/watch?v=GU_NhKcDlxI
https://downloads.softwel.com.np/
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v. This will open the Reset password page. Input the new Password and click on “Reset Password” button.

This will successfully reset the password and we can log in with the new password. 
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Change the Email ID registered for the Softwel Key 

Procedure: 
1. Visit the download page of Softwel.

https://downloads.softwel.com.np/ 
2. Login the page with the account that you have registered the key previously.

3. Your name will appear at the right corner of the page. Click on the Dropdown button and
select Manage Licenses.

4. 

5. List of key details that are registered in your account will be shown. Click on “Unregister”
button.

6. Now the Key is unregistered and you can register the key on another account.
7. For YouTube tutorial visit: https://www.youtube.com/watch?v=IIEqKG80onA

https://downloads.softwel.com.np/
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1 INTRODUCTION (USER INTERFACE) 

1.1 Main Window (Plan Window) 

1.2 Main Toolbar 

1. Draw New Alignment

It is used to draw new horizontal alignment or new 
longitudinal profile.  If the Plan window is active, it starts 
to draw new horizontal alignment and if the profile window 
is active, it draws a new longitudinal profile. If both plan 
and profile windows are active, it works on Plan window. 
If a longitudinal design profile is already assigned, the 
button does nothing in profile. While drawing new 
horizontal alignment, the road name and start chainage of 
the road has to be defined before the start of the new 
alignment. While drawing a new alignment, the 
appropriate radii are auto-assigned. To finish adding IP, 
the user has to right-click on the mouse. 

2. Add IP

This tool adds the IP at the end of the active alignment. 

Horizontal IP 
Property Panel 

Layers
 

Toolbar 

Alignment
 

Navigation 
 

Chainage 
 

Active Alignment 

Measure 

Erase IP 

Move Vertex 

Insert Ip 

Add IP at the end 

Draw New Alignment 

Search Bar 
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3. Insert IP

This tool inserts new IP between two nearest IP of the active alignment. It works on Plan and 
Profile windows. 

4. Move Vertex

This tool is used to move or edit the position of 
the IP . It works on Plan and Profile windows.  

3 different option is available while using this 
tool. 

Free Move: IP can be moved anywhere. 

Backward Controlled Move: IP is moved along 
the direction of backward IP only. 

Forward Controlled Move: IP is moved along the direction of proceding IP only. 

5. Erase IP

This tool is used to erase unnecessary IP in Plan and Profile. 

6. Measure

These tools are used to measure linear distance and area of polygons. 

7. Switch Active Alignment

This drop-down is used to switch the active alignment. 

1.3 Draw Toolbar 

1. Draw Line
2. Draw 2d-Polyline
3. Draw 3d-Polyline
4. Draw Polygon
5. Draw Text
6. Draw Circle
7. Draw Arc
8. Draw Ellipse
9. Add Image
10. Synchronize Drawing
11. Active Layer
12. Filter Points

• While using “Draw Toolbar”, mouse right-click completes the command,
keyboard “Backspace” key undo the inserted vertex.

• “Draw 3D-Polyline” is used to draw the 3d-features that indicate the terrain
undulation such as road edge, steps in terrain, cutting edge, etc.

1
2

3 
4 

5
6

7
8 10 

9 11
 

12
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• All the drawn features are added under active layer. So user has to change the 
active layer as per requirement. 

1.3.1 Layers Panel  

It controls the display of all the designed layers (road width, chainage, extrawidening etc), 
drawn terrain layer (Points, features, contours, etc), imported external layers (drawing file 
(*.dxf), shape (*.shp), geopackage (*.gpkg), etc) and imported raster layers (satellite imagery, 
topographic map, drone images in *.tif or *.mbtiles format). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Designed Layers 

Terrain Layers such as Points, Contours, features, etc. 

External layers such as Drawing *.dxf, Shape, Geopackage 

Raster (Image) layers such as Google satellite image, Bing 
mage, Drone image, etc. 



SW Road V2

4 

1.3.2 IP Properties: 

It is used to display and edit the properties of the selected Horizontal IP. It is the place to 
assign and modify the radius and transition length of the IP.  

• Entering the number in "IPNum" displays the properties of that IP.

• Right click on Radius value gives option for
putting radius by locating the point on the
plan. Clicking this command invokes the
message on the mouse cursor "Pick a point
where you want the center line". User has to
click along the Perpendicular bisector of the
angle on that IP. This command works on the
active IP only.

• Double click on the radius values also execute the command "Radius from Point".

• Double click on value of "Spiral Curve" calculate the length of spiral curve.

Active Alignment 

Radius of curve 

Transition Curve length, Double click on the 
value will auto calculate the length if 
applicable. 

Zoom to active IP instantly 

Zoom to Chainage 
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1.3.3 Alignment Element Display: 

It is used to control the visibility of the alignment. The 
visibility of alignment can also be turn off from the 
Alignment property Manager. (Menu 
bar>Data>Alignment>Properties).  

 

1.3.4 Navigation Tab: 

 
Navigation Tab is used to quickly switch between the various window. The main windows 
available are Plan, Profile and Cross Section. These windows can be arranged in a different 
configuration to make the designing job comfortable. The job will be more comfortable if the 
user uses multiple monitors for parallel referencing.  

1.4 Profile Window 

This window is used to design the longitudinal profile of the road. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Vertical IP 
Property Panel 

Structure List 
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Length of Curve. User can input the appropriate length manually. Double 
click on the value auto calculate the length of vertical curve. 

Update design profile 
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1.4.1 Other Tool 

• Set Design profile to some specific value 

Design profile can be set to some specific value. For this user have to select the design profile 
and double click the design gradient to be changed. Then fill the form as per requirement. 

 

• Move vertical IP (VIP) to some specific chainage 

This can be accomplished by selecting the VIP and changing the chainage of the VIP at 
properties panel. 
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• Calculate Length of vertical Curve (LOC) 

Length of vertical curve can be either input manually or calculate by program itself. LOC can 
be calculated from Data>Design Profile by clicking on “Compute All”. 

 
Length of curve can also be calculated one by one from VIP Properties. 

 
1.5 Cross-Section 

This window is used to design the cross structures such as Retaining wall, breast wall, cut/fill 
slope, drainage, etc. The cross-section menu has been discussed in detail in a separate 
chapter. 
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1.6 Plan-Profile 

 
1.7 Plan – Cross Section 

The cross-section is detachable in this view. If the user has multiple monitors, it can be viewed 
separately. 

Tools for Modifying Structure in Section 

Assigned Structure List 

Properties of Selected Structure 

Tools for re-arranging 
the order of structure 

Display cross section of 
multiple alignment. 

Copy the structures to 
right side. 
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1.8 Profile-Cross Section 
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1.9 Plan-Profile-Cross Section 

 
 

 

 

1.10 Multiple Cross Section 

This window can be used to design multiple cross-sections at once. Multiple cross-sections 
are displayed and action taken will apply for all the displayed sections. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ID: The left and right-side 
structures are listed based 

on ID. 

Rows and 
Columns Spacing 

Number of rows 
and column 
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1.11 3D-View 

3D-model can be viewed either with background terrain or without background. Longer stretch 
of view need more memory. So, it is recommended to view short stretch at a time (around 250 
m or as per the processing speed of system) and regenerate another stretch for next view. 
Cross-section can be viewed from “Show X-section”. For this user has to double-click on the 
carriageway and cross-section will be displayed. 
  

Navigation:  
Left Mouse hold= Pan 
Right Mouse hold= Rotate view 
Middle Wheel scrool= Zoom 
Left Double click=Display cross-section 
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2 MAIN MENU 

The entire system is grouped into menus based on their similarity of functions. The following 
table provides the summary of the menus and the sub-sequent section provides details of 
each of the menus and the sub-menus 
 

 
 
 

Menus Description 

File Allows users to create new project, import project from 
(*swi) file format and import settings from another project, 
create backup copy of project, save and exit.  

Data Most of the data that is required for designing road is 
entered here. Eg: Design Parameter, Design Table, 
Cross Structure, Sub-Surface layers, etc. 

Edit Superelevation and Extra-widening data generated from 
user defined criteria can be edited. 

DTM Surveyed points are processed, contours and terrain 
surfaces are generated. The source of terrain file required 
for the design is selected whether the source is internal 
DTM, external DTM or Grid. 

Utility Update the terrain, temporary raising of ground in 
longitudinal profile, shift the chainage, reverse the 
alignment and generate 3D model of the designed road. 

Compute Recalculate the design criteria based on user defined 
design table. 

Estimate Estimate and prepare bill of quantity of the project 

Output Export the design data, Layout data and quantities of 
work. 

Drawing Export Design Drawing (Plan, Profile and Cross-Section) 

3-D Visualization Display the designed alignment with traffic simulation. 

Help About the system. 
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3 FILE 

File menu has been divided into following sub-
division.  

3.1 New Project 

Create new project with default settings. Users can 
do nothing without creating a project. 

3.2 Open Project 

Open existing project 

3.3 Import Project 

Import Project that has been created by previous 
version of SW_Road (ie. SW Road 2010 in *.swi). A 
single project or multiple projects file can be 
imported. A project can be imported either re-
calculation with new software or without re-
calculation so the quantity and other design elements 
are not altered by new method of calculation adopted 
in the current version of the software. 

While importing the multiple projects, the alignment must be connected at the end and the 
resulting project will be a single alignment with connecting all the alignments. 

 
3.4 Import Project Setting 

Project setting is imported from existing project file. The project setting includes the design 
parameter, extrawidening and superelevation, pavement configuration, soil code, structures, 
material assignment, profile format, etc. 

3.5 Project Details 

The project properties, information and projection system are displayed. The projection system 
can be changed from here. 

3.6 Save Project and Save as Project 

“Save” saves the project where “Save as” saves the project in a new copy and continue in it. 

3.7 Create Backup 

Save another copy of project in the same directory of project file. 

3.8 Merge Projects 

Merges multiple SW road project files (*.swr) into a single project. 
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3.9 Close Project 

Close opened project file. 

3.10 Open Project Folder 

Open the folder containing the current project file. 

3.11 Recent Projects 

. Display the list of recently opened project for quick opening of project file. 

3.12 Exit 

Close the opened project and terminate the program. 
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4 DATA 

Before proceeding to road design, the design requirement and criteria need to be entered. In 
this menu, all the design requirement and criteria are entered. The Data menu is sub divided 
into following sub-menu.  

 
4.1 Design Parameter 

The parameter required for design such as road width, camber slope, design speed, extra-
widening calculation option, etc is defined here.  All the design parameter can be set for 
multiple alignments individually choosing the alignment id. This rule is applied on the rest of 
the tables as well. The setting in Design Parameter can be copied from another alignment as 
well. 

 

4.1.1 Carriageway 

Carriageway is defined as the road width where the movement of the vehicles takes place. 
The designer gives Road width according to the design criteria and the standards for the road 
project. While designing urban roads, standard width of median and new jersey block along 
with the kerb shyness should be included in road width. 

Camber is the slope provided to the road surface in the transverse direction of the road to 
drain off the rainwater from the road surface. The required camber of a pavement depends on 
the type of pavement surface and amount of rainfall. 
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4.1.2 Vertical Alignment Design 

The vertical alignment is the elevation or profile of the centre line of the road. It consists of 
grades and vertical curves and is governed by the design speed, acceleration, deceleration, 
stopping sight distance and comfort associated with the vehicle movement. The design speed 
of roads depends upon the class of the road and terrain. 

 

4.1.3 Super Elevation Design 

Super elevation is the transverse inclination to the pavement surface to counteract the effect 
of centrifugal force and to reduce the tendency of the vehicle to overturn. Super elevation is 
provided to the road by rotating the cross-section line with respect to the centre of the road. 
The parameter “Super Elevation Design By Option” is very much useful for overriding the 
super-elevation value by user. Put the value for this option as 0 or 1 to compute by program 
and put 2 if designer wish to edit the super-elevation data. Then use command “Edit>Super 
elevation” to edit the super elevation table manually. 

 

4.1.4 Extra Widening Design 

Extra widening is simply the widening of road at horizontal curves. As the rear wheels of 
vehicle doesn’t follow the same path as front wheel at bends, the necessity of extra widening 
arises. It provides the easiness to the vehicle for the movement when the radius of horizontal 
curve is less. 

The parameter “EW Design By Option” is for overriding the extra-widening table by user. So 
put the value 1 for this parameter, if designer has to edit the extra-widening data. Then use 
command “Edit>Extra-widening” to edit the extra-widening table manually. 

 

 

4.1.5 Design Override for hill roads 

It allows the user to specify the minimum curve length of the horizontal curves for which 
geometric design is to be carried out for superelevation and extra widening. If the length of the 
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curve is smaller than the value specified by this parameter, no geometric calculation is carried 
out for such curves. 

 

4.1.6 Right of way 

Right of way is the area of land acquired for the road, along its alignment taken from the centre 
line of the road on either direction of the centre line. 

 

4.1.7 Starting Chainage 

It displays the starting chainage of the current alignment. User has to define starting chainage 
while adding the alignment (Toolbar>Draw Alignment). If the starting chainage has to be 
changed during the design or after completion of design, shift can be applied to the 
alignment for changing starting chainage (Menu>Utility>Shift Chainage). 
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4.2 Pavement Configuration 

 
This sub-menu is used to assign the typical cross-section of the road section to the specified 
range. Users can create their configuration from cross-editor in right-click menu. In cross-
editor, add structures as per requirement and choose “Create Section Configuration” in the 
right click menu. The active section will be saved as a section configuration. 

4.3 Design Table: 

This is the main sub-menu for entering the design data. This sub-menu is further divided into 
multiple sub-menus. 
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4.3.1 Superelevation:  

The criteria for applying Superelevation are defined here. If the criteria are not defined by the 
user the pre-input criteria will be adopted based on design speed defined in the design 
parameter. The tables below show the pre-input criteria and custom criteria (SE Entry tab) for 
Superelevation design. 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

4.3.2 Hill-Side Data:  

Hill-side data is used while designing the one side camber road for the direction of the slope 
of camber. The camber will be designed with sloping toward hill-side for draining toward the 
hill-side drain in normal camber. If hill-side is not defined by the user, the system will assume 
hill-side at left. 

 

4.3.3 Extra Widening:  

The extra-widening at curve is calculated based on this table. If the radius assigned in specific 
IP (Horizontal Intersection Point) is not found in the range of input radius, extra-widening will 
not be applied on curve of that specified IP.  
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4.3.4 Side of Extra Widening:  

Side of extra widening is the provision of mode of placement of extra widening to the horizontal 
curves according to the radius of curve. The percentage value is assigned to the value of extra 
widening to place on either inner side of the horizontal curve or the outer. 

 
 

4.3.5 Accelerating and Decelerating Lane 

It is also known as speed-change lane. In the urban road, it provides an opportunity for drivers 
to speed-up or slows down the vehicle.  
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

The acceleration and deceleration lane can be added and modify from this table. 
 

 
 

4.3.6 Median Data 

The median is the reserved area that separates opposing lanes of traffic on divided roadways. 

Decelerating Lane 

Accelerating Lane 
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Multiple medians can be added in the same section from this table. The offset value is entered 
to assign multiple medians on the same section.  

 

 

 

 

 

 

 

 

 

 

The input format of the table shall be described with the given sketch. 

 
The Median can be modified easily with right-click on a row and choose “Modify Data”. A form 
will appear that has multiple options of output with output preview on the right side. User needs 
to fill the form and on pressing “Apply”, the selected row will be modified to give the desired 
modification in data. 

 

 

 

 

 

 

 
  

(1) (2) (3) (4) (5) (6) 
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The function of buttons provided in the main form is presented below 

 

 

 

 

 

 

 

 

 

 

A sample entry in the quick insert median is given below. 

 

 

 

 

4.3.7 New Jersey Block 

A new Jersey barrier is a modular concrete or plastic barrier 
employed to separate lanes of traffic. This table is used to insert 
new jersey barrier in design road. It can be placed anywhere 
along the road by entering the offset distance from the centre. 

 

 

 

 

 

 

 

4.3.8 Pass By 

Pass by is a space provided to pass the slow-moving vehicles. The input table is similar to the 
table of bus bay. 

 

Select the type of Median 

Add drains and shoulder in median 
Quickly insert median with symmetric nature 

Import data from excel 
Export data to excel 

Save the changes and 
incorporate in design Display the preview of selected rows 

Display the description of 
each column in sketch 

Pick the position on plan to assign the median 
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4.3.9 Bus Bay 

A Bus Bay is an indented space adjacent to a traffic lane designed to let buses embark and 
disembark passengers, without hindering the flow of traffic. User can define bus bay from this 
table with varying start and end transition. The same table can be used to define the passing 
zone in narrow road design. 
 

 

 

4.3.10 MBus Bay 

When bus bay has different wearing course and subsurface thickness than the main 
carriageway, the user can use Mbus Bay. User can define an overall thickness of bus bay 
(wearing course+base +subbase thickness). The overall thickness can be distributed while 
defining the bus-bay material. 

 

4.3.11 Lane Distribution:  

While designing urban road, the lane distribution can be defined from this command. 

 

 

 

 

 

 

L1 , L2 R1 , R2 
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Lane offsets: 

It is the position of lane marking line offset starting 
from road centre line followed by offset from next line. 
The two consecutive offset values are separated by 
comma (,). For eg: A road with 4 lane road (3.5 mx4 
No., 2 left lane and 2 right lane) can be input as 
3.5,3.5 as shown above in table “Left Lane Offsets 
(m)”.  
 
 

4.3.12 Tunnel 

The tunnel can be input in this sub-menu. Tunnel sections are shown in cross-section and 
plan. Quantities are not calculated at the tunnel section. 

 

 

4.3.13 Shoulder Data 

This table is used for providing the shoulder data for the road. The shoulder data include width 
and thickness for the desired chainage interval. The thickness can be input with multiple 
layers.  

The shoulder can be edited after assigning in cross-section. The properties of the shoulder 
such as width, thickness, slope, etc can be edited using the tool “Edit Shoulder”. The tool can 
be accessed either from the Shoulder table or from Cross Editor (X-Utilities>Edit Shoulder). 

The slope of the shoulder can also be set equal to the superelevation at the section (in case 
of a superelevated section) by checking the box “Same as Superelevation”.  
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Shoulder Type: Shoulder is the default 
shoulder. New type of shoulder can be 
created from customize structure. 

Actions>Normal: The edit will be applied on 
all sides of section. 

Action>Related to Drain: The edit will be 
applied on the side where drain has been 
assigned. 

Batch Table: When we need to edit in 
multiple ranges, fill the batch table and hit on 
execute batch to get the job done.  

 
 

 
 

 
 

4.3.14 Soil Type Data 

Soil type according to the chainage is defined in this field. Before defining the chainage, soil 
code has to be generated. This can be done by clicking the “View Code” button. This opens a 
form “Soil-Type Allocation”. Soil codes are the abbreviated form of the soil types defined in a 
manner that, when needed, they can be called by their abbreviated form. Similarly, cut, fill and 
foundation cut slopes are also defined in the code segment. Provision for importing the soil 
code is also available from the previously defined project from the excel file. 
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4.3.15 Variable Road Width 

While designing a long road, some stretch has to be assigned different road width than the 
designer assigned in design parameter. In such case, variable road width can be assigned in 
this table and this overwrites the road width at defined sections. 

 

4.3.16 User Chainage 

When cross-section is required at 
the chainage other than the multiple 
of data extraction interval then user 
chainage is defined. For eg: if the 
data extraction interval is 10 m and 
we need a section at chainage 
2+177. Then define chainage in user 
chainage and while updating terrain 
(Menu>Utility>Update Terrain), 
check the box “Include User’s 
Chainage”. Then the cross-sections 
will include this new section as well.  
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4.4 Pavement Layers 

 

4.4.1 Layer Configuration 

 
The properties of the pavement surface can be configured from this table. Before defining the 
pavement configuration, users have to define the configuration in “Create Configuration”. The 
steps in creating a new configuration are enumerated as follows: 

• Enter the name of new configuration.  

 
• Enter the number of layers in the configuration 
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• For each layer, select the layer type and mention the thickness. 

 
 

 
 

The order of task required to edit an existing configuration is shown in below snap. 

 

 
After creating pavement configuration define the chainage and assign the configuration. 
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 “Triangle Part” in the “Pavement Layer Form” indicates 

 

 
The figures below show the differences in output while using and without using the triangle 
part. Entering “1” indicate the use of the triangle part and “0” indicate the ignoring the triangle 
part. The same concept applies to other sub-surface layer and shoulder as well. The triangle 
part will be ignored when there is some structure at the edge of the pavement. 

 

 

 

 

 

 

 
 

4.4.2 Base 

The details of the base layer are entered in this form.  
 

 
 

 

 

 

 

 

 

 

Extend Status mean whether the base layer is to be extended up to fill line or not. “0” indicate 
“No” and “1” indicate “Yes”. Similarly, the “Vertical Status” means whether the vertical or 
sloped edge is to be assigned. “1” mean vertical and “0” mean slope. This concept is the same 
in other sub-surface layers as well. 
 

Edge of base when “Vertical 
Status” =1 is applied. 

Edge of base when “Vertical 
Status” =1 is applied with 
“Extend Status”=0 
 

Edge of base when 
“Extend Status” =1 is 
applied. 

The pavement edge when 
“Triangle Part” =1 is applied. 

The pavement edge when 
“Triangle Part” =0 is applied, ie 
no triangle edge is formed. 
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4.4.3 Sub-Base 

 

4.4.4 Sub-Grade 

 

4.4.5 Capping 

 

4.5 Cross Structure 

The crossing structures are required for water bodies to cross the road. Different type of 
crossing structures can be assigned in the design. 

Work Code 

It is a standard item code for assigning a cross drainage structure. It determines the cost of 
the structure in the bill of quantity (BoQ). Users can create their own work code in SW-Road 
Estimator (Norms>Add/Edit Work Type). 

In case the work-code is left empty, estimator do not include the cost of the structure. 

4.5.1 Causeway 
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4.5.2 Bridge 

 

4.5.3 Pipe culvert 

 

4.5.4 Box Culvert 

 

4.5.5 Slab Culvert 

 
 
 
 
 

4.6 Sign & Symbol 

Different road marking can be assigned from this sub-menu. 

4.6.1 Zebra Crossing 

For Drawing zebra crossing in plan, select a cell in chainage column and press “Draw in Plan”. 
This draws a zebra crossing and save the chainage in the table for future record. 
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4.6.2 Arrow Marking 

It is similar to drawing zebra crossing. The arrow showing direction in lane can be drawn from 
here. 

 

4.6.3 Regulatory Sign 

 
 

4.7 Alignment 

4.7.1 Data Editor 

The horizontal alignment data can be viewed and modified from here. The functions are further 
described on figure below. 
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1. Add: Add new alignment 

2. Import: Import alignment data from the excel spreadsheet. It will be active only on a new 
alignment. 

3. Replace: It replaces the current alignment with new imported alignment. 

4. From Drawing: Select the polyline in drawing and it will be converted to alignment. 

5. Export: It exports the current alignment to excel spreadsheet. 

6. Angle and Distance: Input alignment data in angle and distance. 

 
7. Compute Selected: Update transition curve in selected transition length. 

1 
2 

3 
4 

5 
6 

7 
8 

9 
10 

11 
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8. Compute All: Update transition curve in all IP. 

9. Rename IP: Change the name of IP. 

10. Swap: Interchange the Easting and Northing data. 

11. Auto Radius: Assign radius in IP with zero radii. 

4.7.2 Properties 

Alignment Properties manages the properties of multiple alignments such as adding new 
alignment, deleting/removing, making active alignment, etc. Alignment can be added as the 
offset of another existing alignment. This tool is helpful for designing alignment which is 
parallel to the other alignment. The “Tick” on status column indicates the current active 
alignment. The visibility of alignments can be turned ON/OFF from “On” column. The text size 
of IP name in the plan can be changed from “Text Height” column. 

 
1. Add new alignment parallel to existing alignment. 

 
2. Delete Unnecessary alignment. It should not be current alignment. So, to delete the 

active alignment first make some other alignment as current. 

3. Rename the existing alignment name. 

4. Switch the selected row to active alignment. 

4.8 Existing Profile 

It displays the existing longitudinal profile of roads. “Interpolate”. The RL can be interpolated 

1 
 

3

 
 

4 2 
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from two successive elevations using “Interpolate” command. 

 
4.9 Design Profile 

It is the longitudinal profile of the finished level. 

 
4.10 Cross Section 

After extraction of terrain data, all the cross-section data are saved in project. Cross-section 
data editor is used to view and edit data. The data can be imported from excel data as well in 
the form of partial distance format or stepping data format. 
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A. Import CSV: It imports the excel data in csv format into the project. The data format must 
be as shown below. 

B. Import Excel: It imports the excel data from an opened excel workbook with selected 
range state into the project. The data format must be as shown below. 

 
C. Import Step Data: It imports the excel data into the project when the excel data is in 

stepping format. 

 

B 
C 

A 

D 

F 
G 

E 

I 
J 

H 

K 
L 

N 
M 
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D. Import Level Data: It imports the auto level survey data for cross-section. The format of 
the data must be as shown in the image below. It can import the level data from both csv 
file and excel file. 

 
 

 
E. Import Point Data: It imports the auto level point survey data for cross-section. The format 

of the data must be as shown in the image below. It can import point level data from both 
csv file and excel file. 
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F. Export Current: It exports the current cross-section data. 

G. Export All: It export all the cross-section data. 

H. Insert New: It inserts cross-section at new chainage. For this press “Insert New” button. 
A blank table will appear. Input Chainage at chainage text box and enter rest of the value 
in the table. Then save it. 

I. Insert Interpolated: It inserts the interpolated section. 

J. Delete cross-section: It deletes the current cross-section. 

K. Interpolate RL: It interpolates RL of a cross-section point based on RL of neighbouring 
points based on the selection of rows in the table. 

L. Add Points to Plan: It generate a 3D-Point based on added cross-section points from the 
drawing area and adds the point into the plan with remark as “Generated”. 

M. Update: It updates the modification (change is PD or RL) made in data. 

N. Save: It updates the modification made (addition or insertion of cross-section points) in 
data. 

 
4.11 Option 

It is the option for changing the chainage interval display option and other miscellaneous 
design option. In design, road elements are computed based on the provided interval. So, 
lower the input value, higher will be the accuracy and computation time and vice-versa. 
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Similarly, the background colours of the working space can be changed from “Options>Display 
tab”. 
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5 EDIT 

 

 

 

 

5.1 Superelevation>IP 

The calculated Superelevation data can be viewed here base on horizontal IP 

 

 

 

 

 

 

 

5.2 Superelevation>Chainage 

The calculated Superelevation data can be viewed here based on chainage. When 
superelevation design is in manual mode, the data can be changed and re-calculate 
Superelevation based on this modified data. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Remarks used in the Superelevation table and its description 

Abbreviation Description 
NC Normal Camber 
NC_FC Normal Camber to Flat Camber (0%) 
FC_RC Flat Camber to Reverse Camber (-NC) 
RC_SE Reverse Camber to Necessary Superelevation 
SE Superelevation 
T Transition 
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5.3 Extra widening 

The calculated extra widening can be viewed here based on horizontal IP. When the extra 
widening design is in manual mode, this table is used as source criteria for extra widening 
design. 
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6 DTM 

It is the built-in tools for the generation of a topographic map and terrain model. The available 
tools in the Terrain menu are as shown in the figure. 

  
6.1 Terrain Model 

 
This sub-menu specifies the terrain file to be used for design. The terrain file may be internal 
DTM or external DTM/Grid file. If the data is processed and dtm is created within the SW 
Road, the “Internal Dtm” can be used. Otherwise, external dtm or Grid can be imported for the 
terrain data.  

*.Dtm is the old format of digital terrain model generated by SW-DTM software. Now Grid (*.tif) 
is also supported by the current version. User can import terrain from different DEM source 
such as SRTM, Palsar, etc.  

6.2 Update Terrain 

When data of the terrain is changed during the design process, to update the changes, use 
this sub-menu. The path for the terrain file is defined at Menu>Terrain Model>Use internal 
DTM/Select File. It generates profile and cross-sections of the alignment at an interval 
specified in the “Data Extraction Interval”. 
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6.2.1 Data Extraction 

 
1. Data Extraction 

The cross-section data are extracted at an interval specified in “Interval”. “Left Distance” and 
“Right Distance” are the maximum distance from the centre that will be extracted for the cross-
section.  

2. Option: Include curve BC, MC, EC 

When it is “checked”, cross-section will be generated at the begin of the curve, mid of curve 
and end of the curve as well. 

3. Option: Include user’s Chainage 

When it is “checked”, cross-section will be generated at user-defined chainage as well. User 
chainages can be defined at Menu>Design Table>User Chainage. 

4. Select Alignment 

While updating the terrain, the alignment for which the terrain is updating must be checked. 
When there are many alignments check the only necessary alignments. 

5. Select Layers for Remarks 

When remarks need to be displayed at the cross-section, check the necessary layers. This list 
of layers is generated from imported drawing layers or layers created in “SW-DTM” at “Layers” 
panel in Plan. 

6. Process 

After setting all required options and data, press on “Process” for execution. 
  

1 
 

2 
 3 
 

4 
 

5 
 

6 
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6.3 Points 

 
This sub-menu deals with the points data. It may be the surveyed data or generated data.  

6.3.1 Add Point  

It adds point with user-defined elevation.  When the check 
box for Add Feature Line is "Checked", feature line is also 
added along with the line. 

6.3.2 Add Points Using DTM/Grid 

It is similar to "Add Points". It adds points with the 
elevation from the DTM or Grid.  

6.3.3 Import from Excel 

It imports the surveyed points from selection in excel 
spreadsheet. The total number of column in the selection 
must be 5 and the data must be in the order “Serial Number, X, Y, Z, Remark”. While selecting 
the data, the heading should not be selected.  

 

6.3.4 Import Points from File 

It imports the surveyed points from *.csv format. The data must be stored in the order “Serial 
Number, X, Y, Z, Remark”. The data must be without table heading. 
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6.3.5 Set Point  Block Scale 

It changes the display scale of the points in Plan view. 

6.3.6 Delete Point Range 

It deletes the points from the whole area based on user-
defined point number range. If the check box "From 
selected Objects only" is checked, user have to select the 
area from where points is to be deleted. Then the points are 
searched within that area. So the later method is faster. 

6.3.7 Export Points 

It exports the points to *.csv format. The format of the output table is in the order Serial 
Number, X, Y, Z, Remark”. 

6.4 Draw 

6.4.1 Insert Block 

 

 
 

This tool is used to insert the blocks in the 
plan. The coordinates of benchmark and 
stations should be saved in *.CSV format or 
in opened excel file. The order of data must 
be in the order “ Serial Number, X, Y, Z, 
Station Name”. 

The blocks can also be inserted based on the 
remark used in the points. Choosing "From 
Remarks" will display a dialogue box for 
Remark Query. Once the textbox is filled with 
a part of remark used, it will check if the 
"remark" is available on the points and display 
another dialogue box with the list of block that 
can be inserted. 

There are some blocks that are available by default. If the user wants more blocks, it can be 
imported from the drawing files using "Import Block from Drawing". The imported blocks will 
be available for all the project files. 

The list of available blocks can be restored to the original list by using "Restore Blocks". 
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6.4.2 Grid 

This tool is used to draw/erase the grids and coordinates in the plan. 

6.4.3 Add Boundary 

It creates a boundary line around the survey data for triangulation of points. 

6.4.4 Auto Boundary 

It detects the data and creates boundary lines around the survey data automatically. 

6.5 Triangles 

6.5.1 Draw Triangles 

It draws the triangles obtained after triangulation. 

6.5.2 Erase Triangles 

It erases the drawn triangulation. 

6.6 Terrain Grid 

6.6.1 Show Grid Extents 

It displays extents of the grid terrain in Plan when grid terrain model (DTM>Terrain 
Model>Select File>Grid) is used. 

6.6.2 Erase Grid Extents 

It erases the extents of the grid terrain from Plan. 

6.7 Contours 

6.7.1 Draw Quick Contour 

It allows the user to draw contours with the specified interval. 

6.7.2 Draw Round Contour 

It allows the user to draw smooth and round contours with the specified interval. Option for 
refinement level and rounding factors are provided in the form. User can modify as per 
requirement. Higher the refinement level and rounding factor, smoother will be the contour 
with longer processing time. 
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6.7.3 Contour Annotation 

It allows the user to annotate the elevation of contour at a specified distance. 

 

6.7.4 Erase Contour 

It erases all the contours in DTM layers (not from imported external layers). 

6.8 Generate DTM 

It processes all the points and features and generates dtm file which will be used as internal 
dtm while updating terrain. This function is equivalent to “Points>Process Points” and 
“Triangle>Triangulation” in SW DTM. 

6.9 Show Errors 

While generating dtm, the system may encounter errors due to features intersections. These 
errors can be viewed from this sub-menu.  

6.10 Delete DTM Layers  

It deletes the layers under SW_DTM. If the layers are default layers in SW_DTM, only objects 
in these layers are deleted. Empty layers and invalid entity can also be deleted from the 
command. 

 
 

D
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Right Click Menu on SW_DTM 
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6.11 Import Drawing 

When surveyed data is processed outside the SW Road, all the features need to be imported 
in SW Road. This sub-menu imports such drawings including points, features, etc. These 
drawings can be further processed and modified within SW Road unlike the “Import dxf” in 
layer panel which cannot be edited. The file to be imported must be either *.dxf or *.dwg format. 
If the file is in *.dxf format the process is faster whereas the file in *.dwg file will be converted 
to *.dxf format by the software and imports. So it may take some time and the method is slower 
than previous one.  

 
To import the drawing; 

i. Click on "Browse" and select the file you want to import. 

ii. The "Load" button will be active once the file is selected. Click on "Load". This will list 
all the layers available in the drawing. 

iii. Select the layer that you want to load and click on Import 

If the drawing was imported before, "Load Previous" will browse and load the drawing with the 
same layer selection. The layer can be edited as per requirements. 

6.12 Sync Drawing 

It synchronizes the imported drawing with the external source.  

6.13 View Properties 

It displays the properties of the selected objects in DTM 
layers. The elevation of the points can be modified from 
this “Properties Windows”. 

 

6.14 Export DTM 

It exports the generated dtm file in the format *.dtmb so 
that the same terrain file can be used in another project. 

6.15 Open AutoCad SW DTM 

It is improved and more efficient SW DTM that works on Autocad for data processing. 
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7 UTILITY 

Utility Menu has been divided into following sub-menu. 

 
7.1 Elevated Ground 

“Elevated ground” is a tool to raise the existing ground level by the value of the total thickness 
of pavement and sub-surface layer. It is displayed in a longitudinal profile on checking 
“Elevated GP” in the list of profile component at the right-side panel. 

7.2 Shift Chainage 

When start chainage of the design needs to be changed, this tool is used. The shift value can 
be either positive or negative. The process is non-reversible. So, a backup copy will be made 
at the project directory. 

 
7.3 Alter Alignment Length 

This tool is used to elongate or shorten the alignment length. 
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7.4 Reverse Alignment 

When the start point of alignment is needed to be switched with endpoint, this tool is used. 
The process is non-reversible. So, a backup copy will be made at the project directory. 

7.5 Split Alignment 

This tool is used to split an alignment into 
two alignments at specified chainage. For 
splitting the alignment, the specified 
chainage must be in straight line. If it lies 
on curve, an error message “ Enter a 
valid Chainage. Chainage should be in 
Straight Portion” will be displayed at message bar. 

 
 

7.6 Merge Alignment 

This tool is used to join two 
alignments into one. We have to 
select the alignment from the plan to 
merge the alignment. The selected 
alignment must be connected at the 
end to merge the alignment. 

 

7.7 Save Map To Image 

This tool is used to save the map to 
image with the world file. For using this tool, at least one raster layer must be turned ON.  

7.8 Ground Excavation 

This tool is independent of the currently running 
project. This tool is helpful for calculation of the 
excavation and filling in the construction site. Multiple 
ground data (New and Old ground) can be imported in 
the Ground excavation windows interface and quantity 
of excavation and fill is computed in this tool. Similarly, 
the quantity and drawing can be exported in 
spreadsheet and dxf format respectively. For using 
this feature the cross-section data must be in csv 
format in order Chainage, Partial distance, RL, 
Remark (Optional). 

 

7.9  Cad Tool 

It is a set of tools that works on Autocad.  

7.9.1 Plotter 

It is a batch printing tool. It can print multiple pages in a single command. It can print the pages 
from Model view and Layout view in AutoCAD. It supports all the printer installed in the system 
along with the virtual printer such as pdf printer. In the case of a pdf printer, pages are printed 
in separate pages which can be merged with the help of Tools>Combine>Pdf within the Cad 
Tool.  
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Procedure to Print in Model Space 

i. Open Autocad drawing to print. 

ii. Launch the Cad Tool (Menu>Utilities>Cad tools) 

iii. Select the “Plotter” tab in Cad Tool for plotting. 

iv. Select the appropriate settings and options in Printer/Plotter, Plot Style table, Paper 
Size, plot scale, etc as shown in the above picture. 

v. In Space Option, Select “Model” for printing drawings in the model space. 

vi. Click on the “Pick” button. This will activate the command in AutoCAD. 

vii. Follow the instruction in the command line and pick different points as per instruction. 

 

 
viii. On Cad Tool, click on the “Check” button. This will draw a non-printing line across all 

the sheets to confirm the extends of the sheet. 
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ix. If the drawn lines on the Autocad are on the correct points, click on the “Plot” button to 

print all the sheets. 

x. If we want to cancel executed command, click on the “Cancel” button. 

 
Procedure to Print in Layout/Paper Space 

For printing pages in Layout, all the positions of all the pages must be in the same coordinate 
as that on the first layout. Otherwise, this tool cannot be used for printing. Printing in the Layout 
is almost the same as in model space.  

i. In step (v) while selecting the space, select the Layout and the “Sheets on Last Layout” 
and “list of layouts” will be active.  

ii. Then click on the “Pick” button to pick the point on a Layout on Autocad. (Same as that 
in Model Space). 

iii. The number of sheets on the Last layout may be different from other layouts. If it is 
different, specify it on “Sheets on Last layout” and select the layout names to print in 
the list of Layouts. 
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iv. On Cad Tool, click on the “Check” button. This will draw a non-printing line across all 

the sheets to confirm the extends of the sheet. 

v. If the drawn lines on the Autocad are on the correct points, click on the “Plot” button to 
print all the sheets. 

vi. If we want to cancel executed command, click on the “Cancel” button. 

While Using Plotter it is strongly recommended to use a virtual printer such as pdf printer to 
avoid wastage of paper. A pdf printer that has features of auto naming the pages is 
recommended to avoid the naming of the file repeatedly for all the pages. Such features are 
available on the “Bullzip PDF printer” which is free and can be downloaded easily. It has the 
feature of naming a file by the current time. So, the file name will never be duplicated.  

These multiple files can be merged into a single file using Cad Tools>Combine>Pdf. 

It will open a dialogue box for selecting the files. Select all the files and click on the “Open” 
button. 

The Selected file will be loaded in the Cad Tool in alphabetical order. If the name of the file is 
the time of file creation, then it will be in the correct order itself and no need to re-order the 
pages. If it is required to re-order the file, it can be done by selecting the row containing the 

file name and clicking the up or down button.  

The combined file will be saved at the same location from where the multiple files are selected. 
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7.9.2 Tools 

It is a collection of some AutoCAD tools such as the conversion of line types, exports 
properties such as coordinates, areas, text, block attributes, etc. 
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8 COMPUTE 

This menu is used to re-calculate the various road elements. Following road elements can be 
computed from this menu.  

8.1 All 

This command computes all the elements at once except “Staking” and “Shoulder”. This 
command is nearly equivalent to “Compute All” on the toolbar. The only difference is that 
“Compute All” on toolbar compute only that elements which are not computed previously or 
that need re-compute whereas this “compute>All” on menu-bar compute all the element. So, 
the computation time is longer than “Compute All” on the toolbar.  

 
8.2 Update Design Profile 

It updates the longitudinal profile of alignment and also updates the design elevation in each 
cross-section. 

8.3 Update Cross Design 

It updates the cross-section components. 

8.4 Staking 

Computation of staking is required to display all the structures used in each cross-section of 
current alignment in the plan, so this will help to give an overall idea about the structures on 
the plan of the road. 

8.5 Remove Staking 

Erase the staking lines. 

8.6 Other commands 

The rest of the “compute>Sub-menu” computes only the respective element of the current 
alignment as the name suggests.  
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9 OUTPUT 

After completion of the design, the design data can be exported from this command. Following 
data can be exported from this command. 

  

9.1 Horizontal Curve Data 

It generates designed horizontal curve data. 

 
 

9.2 Vertical Curve Data 

It generates the design vertical alignment data. 

 
 
  

X (m) Y (m)
Length 

(m)
Shift (m)

Radius 
(m)

Apex Dist 
(m)

Length of 
Curve 

(m)

BC of Spiral 
Curve (m)

BC of 
Simple 

Curve (m)
MC (m)

EC of 
Simple 

Curve (m)

EC of Spiral 
Curve (m)

1 246050.990 3120902.686 0.000 302.144 0.000 0.000 0 0 0 0.000 0.000 0+000.000 0+000.000 0+000.000 0+000.000 0+000.000
2 245977.448 3120948.897 86.855 315.194 13.050 11.438 0 0 100 0.652 22.777 0+075.417 0+075.417 0+086.805 0+098.194 0+098.194
3 245891.989 3121034.936 208.123 340.695 25.501 22.629 0 0 100 2.528 44.508 0+185.396 0+185.396 0+207.649 0+229.903 0+229.903
4 245833.403 3121202.182 385.334 274.689 66.006 25.979 0 0 40 7.696 46.081 0+358.506 0+358.506 0+381.547 0+404.587 0+404.587
5 245694.753 3121213.555 524.450 259.849 14.841 35.685 0 0 274 2.314 70.970 0+482.039 0+482.039 0+517.524 0+553.009 0+553.009
6 245645.881 3121204.804 574.099 238.588 21.260 7.508 0 0 40 0.698 14.843 0+559.466 0+559.466 0+566.887 0+574.308 0+574.308

HORIZONTAL CURVE DATA TABLE

IP (Num)

COORDINATE
Cum. Dist. 

(m)
WCB 
(deg)

Def. 
Angle 
(deg)

Tangent 
Length 

(m)

Spiral Curve Data Simple Curve Data CHAINAGE

Chainage (m) Elevation (m) Chainage (m) Elevation (m) Chainage (m) Elevation (m) Chainage (m) Elevation (m)
1 0+000.000 425.812 20 -1+990.000 425.812 0+000.000 425.624 0+010.000 425.436
2 0+042.120 424.228 50 0+017.120 425.168 0+042.120 424.844 0+067.120 424.519
3 0+110.160 425.020 80 0+070.160 424.554 0+110.160 425.550 0+150.160 426.547
4 0+212.040 428.908 20 0+202.040 428.526 0+212.040 428.791 0+222.040 429.056
5 0+405.130 431.769 50 0+380.130 431.399 0+405.130 432.206 0+430.130 433.014
6 0+514.800 437.229 70 0+479.800 435.486 0+514.800 435.818 0+549.800 436.149

VERTICAL CURVE DATA TABLE

VIP No.
VIP Length 

(m)
BVC MVC EVC
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9.3 Cross-Section Points 

It exports all the X-coordinate, Y-coordinate and elevation of cross section points. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

9.4 Property-line coordinate 

It generates the coordinate of left and right-side extremities of designed road. 

 

9.5 Generate Layout Data 

It generates the centerline coordinate of the designed data along with the width of the 
carriageway, extra widening and other road cross-section component width. 

 

9.6 Slope Length of Cut Fill Lines 

Slope length of the cut-fill line can be exported from cross-section editor. So, on clicking it, the 
cross editor window will open. The slope length of cut-fill lines can be exported from cross-
editor menu>Output>Slope Length of Cut-Fill Line. 
 
 
 
 
 
 
 
 

 

X (m) Y (m) Z (m)
Partial 

Dist. (m)
Chainage (m) Easting (m) Northing (m)

Design 
Level (m)

Cross 
Dearing 

(deg)

Partial 
Dist. (m)

X (m) Y (m) Z (m)

540544.340 3093755.734 400.408 5.061 0+000.000 540546.688 3093751.250 400.370 152.358 5.116 540549.061 3093746.718 400.570
540553.226 3093760.321 400.151 5.003 0+010.000 540555.547 3093755.889 400.291 152.358 5.004 540557.869 3093751.456 400.156
540560.553 3093767.135 399.855 7.633 0+020.000 540564.395 3093760.540 400.270 149.781 6.220 540567.525 3093755.166 400.392
540563.338 3093770.592 400.036 7.672 0+030.000 540570.598 3093768.113 400.303 108.853 6.329 540576.587 3093766.068 400.352
540564.531 3093775.983 400.211 6.131 0+040.000 540570.351 3093777.909 400.341 71.687 6.352 540576.381 3093779.905 400.880
540561.257 3093785.433 400.131 6.269 0+050.000 540567.209 3093787.403 400.375 71.687 6.333 540573.221 3093789.393 400.857

PROPERTY LINE COORDINATES
Left Extreme Point Center Point Right Extreme Point

0.00 0.00 -1.50 0.00 0.00 -3.50 2.50 0.00 0+000.000 545293.188 3100353.000 425.812 88.001 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00
0.00 0.00 -1.50 0.00 0.00 -3.50 2.50 0.00 0+003.720 545293.318 3100349.285 425.672 88.001 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00
0.00 0.00 -1.50 0.00 0.00 -3.50 2.09 0.00 0+013.720 545293.667 3100339.291 425.296 88.001 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00
0.00 0.00 -1.50 0.00 0.00 -3.50 -0.77 0.00 0+023.720 545294.015 3100329.297 424.941 88.001 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00
0.00 0.00 -1.50 0.00 0.00 -3.50 -2.50 0.00 0+033.720 545294.358 3100319.303 424.680 88.132 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00
0.00 0.00 -1.50 0.00 0.00 -3.50 -2.50 0.00 0+043.720 545294.667 3100309.308 424.516 88.323 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00
0.00 0.00 -1.50 0.00 0.00 -3.50 -2.50 0.00 0+053.720 545294.943 3100299.311 424.451 88.514 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00
0.00 0.00 -1.50 0.00 0.00 -3.50 -1.37 0.00 0+063.720 545295.185 3100289.310 424.485 88.685 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00
0.00 0.00 -1.50 0.00 0.00 -3.50 1.49 0.00 0+073.720 545295.414 3100279.313 424.596 88.685 0.00 -2.50 3.50 0.00 0.00 -1.50 0.00 0.00

PassBy 
(m)

Shoulder 
(m)

Drain (m) FootPath 
(m)

Median 
(m)

Median 
(m)

Cross 
Slope (%)

Carriage
Way (m)

Extra 
Widenin

LAYOUT DATA
LEFT

Chainage 
(m)

Easting (m) Northing (m)
Design 

Level (m)

L-R WCB of 
Cross Line 

(deg)

RIGHT
RemarksFootPath 

(m)
Drain (m) Shoulder 

(m)
PassBy 

(m)
Extra 

Widenin
Carriage
Way (m)

Cross 
Slope (%)

S.N. Chainage (m) X (m) Y (m) Z (m) Remarks
1 0+000.000 246044.854 3120892.921 713.306
1 0+000.000 246049.927 3120900.994 706.695
1 0+000.000 246050.990 3120902.686 706.782
1 0+000.000 246051.110 3120902.878 706.792
1 0+000.000 246051.443 3120903.407 706.819
1 0+000.000 246051.840 3120904.039 706.755
1 0+000.000 246052.668 3120905.357 706.662
1 0+000.000 246058.971 3120915.387 697.733
2 0+002.500 246040.892 3120891.315 715.341
2 0+002.500 246041.245 3120891.877 715.005
2 0+002.500 246047.568 3120901.939 706.766

Cross Section Points
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9.7 Export All 

It exports Horizontal curve data, vertical curve data, property line coordinate and cross section 
points data in a single spreadsheet file. 

9.8 Export Data Items 

This command exports all the selected data table that has been used for the design of road. 
 

 

9.9 Salient Features 

It exports the salient features of the project into the excel. 
 

9.10 Export KML / Geopackage /Shape 

This tool exports the designed layers to Keyhole Markup Language (*.KML), Geopackage 
(*.gpkg) and GIS Shapefile (*.shp) format to view in Google Earth or GIS software such as 
Qgis, Arcmap, etc.  

Line Item Slope(1V:mH) Length(m) Line Item Slope(1V:mH) Length(m)
0+000.000 CutFillLine1 0.33 4.111 CutFillLine1 0.33 4.728
0+003.720 CutFillLine1 0.33 4.022 CutFillLine1 0.33 5.131
0+013.720 CutFillLine1 0.33 4.068 CutFillLine1 0.33 4.583
0+023.720 CutFillLine1 0.33 3.463 CutFillLine1 0.33 4.274
0+033.720 CutFillLine1 0.33 2.235 CutFillLine1 0.33 3.834

Slope-Length Data

Chainage
Left Right
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10 ESTIMATE 

10.1 Quantity Estimate 

 
This sub-menu is used for quantity estimation. It exports all the quantity of works. While 
exporting quantities, error messages may be displayed stating that “Insufficient ground profile 
on …….”. Users have to review on that specified chainage. We can correct it by adding ground 
section data or by modifying the design. If we ignore it, some area will be missed from quantity 
calculation. 

 

 

 

 

 

Quantity extraction has different options.  

1. Compute Quantities 

It compute all the quantity. Rest of the commands will be active only after computation of 
quantities. 

2. Export Abstract 

It exports an abstract of quantity. 

3. Export All Quantity 

 It will export all the quantity in details. 

4. Export Range 

It will export the quantity only within the range specified in “Start Chainage” and “Final 
Chainage” 

5. Export Summary 

It exports quantities in a summarised format. Earthwork will be calculated at the interval 
specified in “Earthwork Chainage Interval” and structures quantity are exported without the 
material type. 

6. Export Summmary in Range 

It will export the summary of quantity only within the range specified in “Start Chainage” and 
“Final Chainage” 

7. Open Estimator 

It opens SW Road Estimator for detail Cost estimate. 

8. Open Estimator for Range 

Error 

This area will be ignored 
while computing the quantity 
if error is not corrected. 

1 

5 

3 2 4 

7 
6 
8 

9 10 

Chainage Range 
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It opens SW Road Estimator that estimate the quantity within the range specified for detail 
Cost estimate. 

9. Summary of Cost 

It displays the summary of cost of the project. The rate of the item must be defined in SW 
Road Estimator. 

10. Summary of cost in Range 

It displays a summary of the cost of the selected range.  

10.2 Cost Estimate 

Before running “Cost Estimate” users have to compute quantity (Estimate>Quantity Estimate, 
and not necessary to export). Otherwise, it uses the last computed data. 

Then go to menu “Estimate>Cost Estimate”. This launches the SW-Road Estimator. 

 
 

 
 
 
 
 

10.3 Multiple cost Estimate 

When it is required to estimate the cost of multiple alignment in a single BoQ, then this is the 
option for the purpose. 

10.4 Import Estimate Settings 

This tool is used to import the settings and changes made in default setting from another 
project. The changes may be the addition of custom rate analysis, analysis for unit structures, 
etc. 

10.5 Remove Redundant Files 

This tool is used to clean the redundant files which are generated during the process of 
quantity calculation and no longer require. 

10.6 SW Road Estimator 

10.6.1 Norms 

 

I. Edit Norms 

This sub-menu provides the rate analysis for different standard items. The standard items are 
locked for editing. However, users can create a new group and new rate analysis. 
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Steps to add a new group and norm Item are given below. 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I. Right-click on “Activity Group” list and select “New Group”.  

II. Blank space will be created and fill the Group code, Activity Group and click on “Add 
New Group”.  

If you have an existing group, step 1 and 2 can be skipped. 

Select the Activity group where norm id needs to be added. 

III. On Norm Item, right-click and click on “Add New” 

IV. A blank space will appear where you have to fill Activity No, Short Description, Full 
Description, Specification (Optional), Quantity of Analysis and Unit. Then click on 
“Save” 

A norm will be added on Norm Items. Double Clicking on created norm item will open another 
dialogue box where human resource, material, equipment, standard norms and its quantity 
can be added. 

 
Add labour, material, equipment, Norms and miscellaneous item as per requirement and click 
on Save. 

 

1 

2 

3 

4 
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II. Add/Edit Labour/Material etc 

This sub-menu provides the rate analysis for different standard items. The standard items are 
locked for editing. However, users can create a new group and new rate analysis. 

 
1. Right-click on Work types and select “Add new Work Type” 

2. Faded “Add/Edit Details” will be active and add work code, work type and unit and click 
on “Save” 

3. Double click on newly created work Type (Red in Colour). 

4. Detailed Standard Quantity Estimation dialogue will open. 

 
5. Define the Norm group, item, location and quantity. Then Click on “Add new”. Repeat 

the procedure for all the works. 



 
 
 
SW Road V2 

65 

If work type is already defined in some other project, it can be imported from “Import Work 
Type from Other Project”. The work code should be different from work code in current project 
to import the work type. 

III. Add/Edit Labour/Material etc. 

This sub-menu opens a form for entering and editing rate of labour, materials, equipment and 
other miscellaneous items. The item can be added from the right-click menu. Items can be 
added based on the categories such as Labour, Material, Equipment and Miscellaneous. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Labour 

The human resources are entered in labour categories. Skill, unskilled, engineer, driver, etc 
manpower are entered in this form. 

2. Materials 

All the construction materials are entered in this form. Users can add and edit the materials 
along with the Unit, weight per unit quantity and Ease of transport. Weight per unit quantity 
and Ease of transport will be used for the calculation of transport cost. If it is ignored, the 
transportation cost for that item will not be calculated. 
 

 
 

Right-click menu 
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3. Equipment 

All the equipment used in the construction is added under this category. Basic equipment such 
as dozer, roller, crane, tractor, generator, etc. has been already added in the list. However, if 
the user wants new equipment, it can be added. 

4. Miscellaneous 

The item whose quantities are assigned as some percentage of other items is placed under a 
miscellaneous item. Some examples of miscellaneous items are tools and plant, laboratory 
testing, insurance, etc. 

10.6.2 Preferences 

This sub-menu provides the rate analysis for different standard items. The standard items are 
locked for editing. However, users can create a new group and new rate analysis. 

 

10.7 Import Estimate Settings 

This sub-menu imports estimate settings such as item rates, rate analysis, etc.  

 

10.8 Cost Estimate 

10.8.1 Rates 

 
1. Transportation Distances 

Materials source and distance of the source to the site are entered in this form. 
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2. Transportation Rate 
Transportation Rate can be 
defined with two methods. One 
with the district rate and another 
with DOR standard rate of 
analysis. 
 

 

 

 
 
 
 
 
 
 
 
 
 

 

10.8.2 Rate Analysis 

 
1. View Summary 

This Sub-menu is used for viewing the summary of item rates. The items which are used 
in the project are shown in the list. 

Form for entering Transportation rate 
as per District Rate 

Form for defining Transportation rate as per DOR norms for rate analysis 
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2. View Detail Rate Analysis 

This sub-menu is used to view the detail rate analysis used in the project. The item which is 
used in the project is shown in it.  
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10.8.3 Master Quantity 

The cost of standard items is listed in master quantity. Quantity for additional items can also 
be assigned in the project from here. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10.8.4 Cost Estimate 
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1. View Bill of quantity (BOQ) 

This sub-menu is used to view the BOQ of the project. 

 
2. View Material Breakdown Details 

This sub-menu is used to view the total material used in the project. 
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10.9 Report 

 

10.9.1 Export Estimate Report 

 

This sub-menu is used to export the estimation report to excel format.  
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11 DRAWING 

 
  

The design drawing can be exported to *.dxf format which can be further opened with many 
drafting software such as Autocad, Nanocad, Draftsight, Intellicad, etc. 
 

11.1 Alignment 

Alignment can be exported with the viewport, without viewport and stripe plan. For reporting, 
alignment with viewport is appropriate whereas for overall viewing the alignment “Without 
Viewport” is suitable. Stripe plan is suitable for viewing the structure along the alignment which 
can further be used for road inventory. 

11.1.1 With Viewport 

With this command, the user can export plan with viewport and frame. To export plan with the 
frame, users have to check “With Frame” and specify the sheet block name. Then press on 
“Draw Layouts” button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After pressing this button, the output window will open with the “Options” menu. Then the user 

Check this box to draw 
the alignment with Frame 
(Name-Plate) 

Select the name of the 
frame. 
The contents of Sheet 
Block Name can be edited 
from Drawing>Edit Plan 
Template. 

Check this box to export 
visible dtm layers along 
with the alignment 

Check this to export the 
plan with cross drainage 
details. 
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can either export the drawing to *.dxf or open directly on drafting software for further editing. 
The behaviour and options in “Output window is the same for other drawings output (profile, 
cross-section, stripe plan) 

 
 
 
 

11.1.2 Without Viewport: 

 

With this command, the user can export plan without viewport and no frame. It is a basic export 
of plan for viewing the overall plan of the design road. 

11.1.3 Stripe Plan: 

It is the overview of assigned structures shown in a straight path. It can be used during the 
inventory of roads. 

 

11.2 Profile 

With this command, the user can export Horizontal Profile. On clicking Drawing>Profile, a 
dialogue box with multiple options will open. On clicking “Format Editor”, the dialogue box 
expand that has more options to set the output such as scale, data to include in the profile, 
etc. 

 

 
  



 
 
 
SW Road V2 

74 

11.3 Plan-Profile 

It is the improved form of export alignment with viewport and profile. For data to be set under 
horizontal profile, user has to defined it from “Drawing>Profile>Format Editor”. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

11.4 Cross-Section 

User can export design cross-section from this menu.  
 

1. Include All 
Exports all the sections as per the entered row and column number. 

2. All 
Export all the sections in the single page. 

3. Fixed Interval 
Export the sections in the defined interval of chainage. 

4. Include User's Chainage 
Export the cross section including the user defined chainage while exporting the 
section at fixed interval. 

5. Downward Draw Order 
It control the order to drawing section in the page (From top to bottom or bottom to 
top) 

6. Drawing Option 
It allows users to export with design or without design (ie existing ground only) 

7. With Frame 
Check to export cross-section with frame. 

Setting for Plan 

Setting for Profile 

Jump to the 
Setting for Profile 
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8. Trim GP 
Check to trim excess ground profile to make the drawing clean. 

9. Other Section 
Check to draw the section of the nearby alignment with the current alignment. 

10. Area Option 
It will be active when "Write Area" in Options in checked. It allows users to export 
cross section with area of checked items only. 

11. Trim GP Option 
It will be active when "Trim GP" in Option is checked. It is the option for choosing 
whether to trim up to RoW of road or up to the defined distance from the last assign 
structure. 
 

 

 
 

 

11.5 Edit Plan Template 

This sub-menu opens the template file for plan and profile in AutoCAD. User can modify the 
template files as per requirement and save with different name. The saved template files can 
be then used while exporting plan with viewports. 

11.6 Edit Cross Template 

It is similar to “Edit Plan Template”. This sub-menu opens the template file for cross-section 
in AutoCAD. 

 

11.7 Change editing App 

While editing the plan and cross template,  application once use for editing will be used next 
time as well. So, if the application needs to be changed, it can be changed from this sub-
menu. 
 

9 
8 

1 

10 
11 

6 

2 
3 

5 
4 

7 
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12 3D VISUALISATION 

 

12.1 3D Visualization 

This tool is used to view the 3D-model of the designed road in animation mode where user 
can drive a car model in the road which they have designed. All the structures assigned on 
the project are displayed on the model along with the background terrain. Either active 
alignment or multiple alignments can be viewed in 3D-Model. 

 
 
  

Shortcut 
Key for 
control 
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13 HELP 

 
13.1 Search (Ctrl+F) 

User can search and open a form for data entry. On entering the text, the result will be shown 
instantly. Then selecting a result and pressing apply will open the corresponding form dialogue 
box. User can access this command through a keyboard shortcut (CTRL) as well. 
 

 
  

13.2 Manual 

It opens the user operation manual for the SW Road software. 

13.3 Download 

It opens the website for downloading the free utilities from Softwel. 

13.4 Check For Updates 

It checks whether the update is available or not. If update is available user can log-in the 
Softwel Account and download the updates. 

13.5 About 

It displays information about the software such as version number, features, development 
credits, etc.  
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14 MENU IN CROSS EDITOR 

Beside the main menu, there is another menu in cross editor. 

 
14.1 Structure Profile 

 

 

14.1.1 Compute Road Edge Profile 

It compute the profile of the road at left and right edge of the 
road. The profile is displayed along with longitudinal profile of 
the road center in profile window.  

14.1.2 Export Road Edge Profile 

After computation of the road edge profile, it can be exported 
to spreadsheet from this command. 

14.1.3 Compute Drain Profile 

To show the longitudinal profile of the invert level of side 
drains, it needs to be computed. After computation user can check on “Left Drain Levels” and 
“Right Drain Levels” to display the drain profile on longitudinal profile. 
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14.1.4 Edit Drain Profile 

The drain profile can be edited on drain profile editor window. 

 

14.1.5 Export Drain Profile 

After computation of the drain profile, it can be exported to spreadsheet from this command. 
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14.2 X-Utility 

  

14.2.1 Assign Materials 

It is used to assign materials to each and every part of a structure. Material has been assigned 
to all the structure component by default. However, if the user wishes to edit the materials and 
norms used for rate analysis, it can be done from this form. 
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a. Settings: 

It is used to change the materials of pavement quickly.  

 
b. Assign Default 

If you have changed the materials and you want the default materials back, then this tool will 
restore the default materials. 

c. Assign 

After changing the material/name/norms, “Assign” saves the changes. 

14.2.2 Import Structure Settings 

The structure properties once edited can be imported from this tool. It can be imported either 
from structure setting file or from the project file. 

14.2.3 Export Structure Settings 

The structure properties once edited can be exported from this tool. 

14.2.4 Edit shoulder 

The shoulder once assigned to the cross-section can be easily edited with this tool. Refer 
4.3.13 Shoulder Data for details. 

14.2.5 Edit Structure Properties 

This tool is used to change any properties of the assigned structures such as base thickness, 
top width, etc. 

14.2.6 Compute Staking 

Computation of staking is required to display all the structures used in each cross-section of 
current alignment in the plan, so this will help to give an overall idea about the structures on 
the plan of the road. 

14.2.7 Extract Intersecting Chainage 

When there are multiple alignment running 
parallel, the chainage of cross section meets 
different chainage in another alignment. So, 
this tool extracts the chainages in all 
sections.  

14.2.8 Overwrite Design Item Wise 

This command is used to copy the structure 
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from another project file based on the section ID regardless of section chainage. 

14.2.9 Copy Design Chainage Wise 

This command is used to copy the structure from another project file based on section 
chainage. 

14.2.10 Copy Structures (Ctrl+Shift+C) 

This command is used to copy section to range of chainage. User has to define source section 
chainage or section Number and chainage range to paste the structure. 

14.2.11 Add/Remove Structures (Ctrl+Shift+A) 

This command is used to add or remove 
certain structure at defined chainage range 
at defined side.  Shortcut for this command is 
“Ctrl+Shift+A”. 

 

 

 

 

14.2.12 Insert Structures (Ctrl+Shift+I) 

 
This command is used to insert a structure before or after any other structure. Shortcut for this 
command is “Ctrl+Shift+I”. 
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14.2.13 Find and Replace Structure (Ctrl+Shift+F) 

This command is used to search certain 
structure and replace with another structure. 
Shortcut for this command is “Ctrl+Shift+F”.  

 

 

 

 

 

 

14.2.14 Trace Quantity 

This command is used to trace the quantity of work up to  the current design. On updating or 
editing the structure section wise, the quantity also updates at the same time. 

 

14.2.15 Mass Haul Diagram 

This tool draws mass haul diagram. User can export it to dxf format and do further planning 
for economic mass movement. 

14.2.16 Favourite Structure 

There are too many structures in the list. So, to keep some 
specified structures at top of the list, this tool is used. 

 

 

 

 

Favourite Structures at top of the list in 
different colour. 

Quantity of work in active section. 

Overall quantity of project that 
updates on every change in section  
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14.2.17 Customize Structures 

It is the tool for customization of existing structure and save as new structures. This new 
structure will also be listed in structure list for assigning to cross-section. 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

14.2.18 Customize Gabion Box Count 

It is counting of gabion box of 
different size while using on the 
section. A default counting is 
provided in the form. User can 
modify as per requirement. It is 
used for quantity calculation of 
gabion mesh area. 

 
  

Source structure selected for customization 

New structure name for saving 

New structure after customization 
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14.2.19 Options 

Different options for design are available in this form. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

14.3 X-Output 

14.3.1 Slope Length of Cut Fill Line 

It exports the slope data to excel format. The exported data contains slope length and adopted 
cut and fill slope of Cut/Fill line and Benching line. 

14.3.2 Quantities 

This sub-menu is used to export the quantity of works. For detail refer Chapter 10: Estimate.  

14.4 X-Drawing 

14.4.1 Draw Current 

It exports the current cross-section displayed in cross-editor. 

14.4.2 Draw All 

It exports all the cross sections. Refer Chapter 11 for details. 
 
 
 
 
 
 

Cut/Fill Lines updated based on slope assigned on Soil 
Type Data. But It will not be updated by Compute All 
or Compute Force unless “Update Cut Fill Lines 
Slope” is checked. 

Shoulder will not be updated by Compute All or 
Compute Force unless “Update Shoulder” is 
checked. 

It controls the grid interval in cross 
editor and exported cross section 
drawings.  

These are the criteria govern the height 
of dynamic wall.  

Control whether Zoom Extent is to be performed or not 
while navigating the cross sections. 
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14.5 Other Features 

14.5.1 Group structures 

When some structures come in same order frequently, grouping such structures can make the 
task fast. To group the structures, select the structures in the order of application and right 
click on the structure and apply “Group Structures” from the menu. Give a name and save it. 
The name of the group is listed at the end of the list of structure. It can be assigned on cross 
section as any other structure.  
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15 NEW IN SW ROAD V2 OVER SW ROAD 2010 

15.1 Improved Computational Speed 

The Computational speed has been improved drastically. 

15.2 Added Mouse Navigation Control 

Mouse wheel control has been added. Now user can easily zoom-in and zoom-out. For zoom 
extent, users can double click on the middle wheel. 

15.3 Compatible with the previous version of the software 

With the new version of the software, new improved file format (*.swr) has been introduced. 
For opening the old format file, user has to import file. The software will convert into the new 
format. Multiple old format file can be now combined importing multiple project files at once. 

15.4 Support background imagery 

Background images can be imported for the reference base map. Geo Tiff (*.Tif) and Mbtiles 
(*.Mbtiles), tiff file can be imported as background from local drive and XYZ-tiles can be 
imported online. Users have to input once the URL link for the tiles and it will be saved until 
the software is uninstalled. URL link of XYZ tiles for difference imagery services can be found 
easily on the internet. Some sample links for tiles has been provided below; 

SN Image URL Link 
1 Open Street Map http://tile.openstreetmap.org/{z}/{x}/{y}.png 
2 Open Topo Map https://tile.opentopomap.org/{z}/{x}/{y}.png 

15.5 3-D Visualization 

SW Road can now 3D view of the design roads. Each and 
every structure assigned can be viewed in 3D-model with real 
terrain and background view. So, the design can be optimized 
with this feature. No extra tedious effort is required for this task.  

15.6 Left side layer panel 

User interface has been improved. The right-side panel (in 
older version) has been divided into the left and right-side 
panel in the current version. 

• Details from Dwg File  

Now the software imports *.DXF file instead of *.Dwg file. It has 
been placed under “External Layers” in layers panel. Right-
click on “External Layers” has menu for importing *.dxf file. The 
layers of imported DXF file will be listed under “External 
Layers”. 

• Road Element 

The design road elements have been placed under left side 
layers Panel. 

15.7 Compatible with GIS Shape file (*.shp), 
Geopackage (*.gpkg) 

User can import shape file and geopackage file for background 
reference with UTM or MUTM projection system. It is placed under 
“External Layers”. It can be imported same as DXF file. 
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15.8 Right Side multiple Alignment Display control 

As the road support multiple alignments, a list of alignments will be displayed at the right-side 
panel. The visibility of design road elements of the corresponding road can be switched from 
this panel.  

15.9 Compatible with multiple alignments 

Users can design multiple alignments in the same project. Design parameter can be set for all 
the alignment separately as per requirement. 

15.10  Urban Road Components 

Multi-lane alignment can be designed in the newer version. So urban road can be designed 
now. Urban road components such as median, new jersey block, speed change lane 
(acceleration and deceleration lane), footpath, kerbstone, handrail, lane separator, sign and 
symbol, bus-bay, etc have been added. 

15.11  Support DEM terrain 

SW Road now supports DEM terrain layer. SRTM, Alos Palsar, Aster, etc dem can be used 
(*.tif format) for designing roads. This feature may be helpful while undertaking a feasibility 
study of road.  

15.12  Auto-Calculation of curves 

• Radius of curve 

The software now inputs the best fit radius of curve in all horizontal IP while drawing new 
alignment. 

• Calculate spiral length 

The software now calculates the transition curve at every horizontal IP where applicable. It 
calculates the spiral length on double-clicking on the spiral length input field. It can be 
calculated for all the IP from the “Alignment Editor” form. 

• Vertical curve length 

The vertical curve length at every vertical IP can be calculated. The procedure is similar to the 
spiral length calculation. 

 

15.13 Terrain Menu (Integrated SW DTM) 

SW Road has built-in SW DTM that works in SW Road environment. Autocad is no more 
compulsory software for preparing terrain file and background reference. However, the terrain 
and map prepared in AutoCAD are still supported in the current version. All the functions 
included in SW-DTM has been integrated into this version. “Contour Annotation” feature has 
been Improved that needs no manual input as the previous version of SW DTM does. 

Besides this, a separate SW-DTM is also included which works on Autocad. The processing 
speed has been improved with options of drawing refined and smoothen contours. 

15.14  Reverse Alignment 

User can reverse or flip the alignment as per requirement without any cumbersome effort. 

15.15  Easily assign hairpin bent 

User can insert or remove hairpin bent easily. 
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15.16  Drain Profile 

User can view drain profile along with the longitudinal profile and drain profile data can be 
exported easily. 

15.17  Cross-Editor 

• Keyboard and mouse control added for selecting and deleting structures 
• Many types of structures have been added such as a Dynamic Retaining Wall, 

Breast Wall, Benching, Mixed wall, Covered Drain, Sub-Surface Drain, Circular 
Drain, Guard Block, Crash Barrier, Handrail, Delineator, Composite Wall, etc. 

• The order of assigned structures can be re-order. 
• The assigned structures can be grouped and named with a user-friendly name. This 

name is listed in the structure list and all the structures in the group can be assigned 
easily as any other structures. 

• Assign Materials 

The material and Government Norm ID can be assigned to the components of the structures. 
It is used for the preparation of BOQ.  A default material has already been defined. It can be 
re-defined as per user requirement. 

• Customize Structure 

User can now modify the existing structure and give a unique name. This name can further be 
used for assigning structure. 

• Export and import Structure Setting 

User can now export all the structure setting and import these settings on another project. So, 
users do not have to modify structures in every project. 

• Copy Structures 

User can copy structures assigned in a section to a range of sections easily. 

• Trace Quantity 
User can now trace the total quantity while designing the road. This feature updates 
the total quantity instantly when cross-section or structure is changed. 

• Mass Haul Diagram 
• User can draw mass haul diagram and use it for further planning of mass movement. 
• Favorite Structures 

In the list of structure, user can put the structures at the top of the list which is going 
to be used frequently. 

• Customize Gabion Box Count 
Users can customize the gabion count as per requirement based on size of gabion 
box. 
 

15.18  Warning for insufficient Ground profile 

When ground data is insufficient in cross-section, the exported quantity may not include the 
whole quantity. In such a case, there will be an error in quantity. So, the software will warn 
you in cross-section and while exporting the quantity. The users have to rectify it to get the full 
quantity.  

15.19  Multiple cross-section Editing 

A separate window has been added to work on multiple cross-sections. User can assign 
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structures in multiple sections at once. 

15.20  Drawing in Print Ready Format. 

Plan and profile can be exported in the viewport with a single command. Cross-section 
drawings can be exported with frame.  

15.21  Quantity 

Quantity export in detailed and summary format with DOR Norm ID.  

15.22  Bill of quantity 

The estimating tool has been added which can estimate and prepare BOQ with ease. 

15.23  Export To Google Earth 

User can now export their design directly to kml format to view in google earth. 
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